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How do I login to the learning management system (LMS)? 

 
1. Open your web browser and type in the link provided to you by your club, such as 

http://verticlimb.learn.com/cli/yourclubnamehere.   
 
You will be taken to the main login page, like the one pictured below. 

 

 
 

2. Enter your assigned Username and Password.   
3. Click the “Enter” button or tap the Enter key on your keyboard. 
4. The first time you enter the site you will be asked to answer three password recovery 

questions.  
 
Note: Password recovery answers should be easy for you to remember.  You will answer 
these questions if you forget your password.  You will be able to change your password 
immediately and directly using the screen. 

 

 
 

5. Type in your answers and click “Verify.” 
6. You will be taken to your personal learning home page.  

 
 

  

http://verticlimb.learn.com/cli/yourclubnamehere�
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Navigation Panel  

The navigation panel is located on the left-hand side of the screen.  It contains many of the features you 
will use now and in the future.  As functionality of the learning management system (LMS) is expanded, 
so will your use of the navigation panel.  For now, you will find the button links located under “About 
Me” most useful for completing your training. 
 

 
 
 

Icon/Button What it does 

 Your assigned courses appear on this page as Development Plans under 
the page heading : “My Training & Development” 

 Your course history, grades, completion dates and certificates are listed 
on this page. 

 Your name and job information is here. You can reset your password on 
this page. 

 This is a general library with titles to supplement the safety courses 

 This is not active.  This will be activated at a later date. 

 This is not currently in use.  This will be activated at a later date. 
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How do I take a course? 

1. Your required courses are listed under My Training & Development.  You will see this screen 
by default when you login.  

2. Click on “My Training” any time you wish to return to this screen. 
3. To view your required courses, click on the plus sign   .  Your assigned course titles will 

display in a list.  
4. Click on the title of the course you wish to begin.  You will be taken to the course launch 

page. 
The title of the course will appear in the upper and lower left-hand corner of the screen.   

5. Click on the launch link “Click here to launch the course” at the top of the screen.  
 

 

TIP: The courses have sound. Make sure your computer sound is 
turned on and you have headphones or speakers attached. 

6. Once the course has launched in your browser window, it will automatically advance to the 
title slide.   

7. Click the blinking “Play” button at the bottom of the course screen to advance to the next 
slide. (When the course animation and sound stops playing, you will need to click the “Play” 
or “Forward” button to progress forward in the course. 
 

TIP: You can click the “Pause” or “Back” button if you wish to 
review parts of the course.   
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8. Once you have gone through the entire course, there is a short quiz.   
- You must get a score of 80% or better to pass the course.  
- You must pass the quiz in order to receive your Certificate of Completion. 
- You may retake the quiz if you do not pass the first time. 

9. To exit the course prior to completing the quiz, click the “Exit” button in the upper right 
hand corner.   

10. Next click the “Exit now” button.   
11. Click on the X button to bring you back to the launch page.   
12. Click the “Stop” icon to return you to your homepage. 

Course Launch Page Icons 

This table explains the icons you will see on the course launch page. 
 

Icon What it does 

 
Click to finish the course and return you to your homepage.  Even if you 
are not finished with the course, it will hold your progress in the course 
and return you to your homepage. 

 
Click to see your course summary.  This button will not reflect your 
course score.  Even if you have completed the course, it will not display 
the score.  

  Click to display the course chapter names. Current CLI courses are only 
bundled into one chapter, only one name will appear.  As we create 
more course content through the learning platform, this chapter menu 
will change.   

 Click to display the Search, Dictionary, and Notes panel. These are 
double angle brackets in the upper right-hand side of the course launch 
page.  

 
Write and save your notes.  You may toggle back to the course launch 
page to display the “Notes” panel during your course to take notes.  Type 
notes in the panel and click the “Save” link.  Your notes will always be 
available for viewing from your My Training & Development page.   
 
Attention:  Admins and Supervisors will be able to see your “Notes” page 
if they run a report on your training progress. 

 
Not active.  This function coincides with course chapters that have been 
built inside of the learning platform.  Once active, the search function 
will allow you to search for a term within the course and return the 
appropriate pages. 

 Search the dictionary.  You may toggle back to the course launch page to 
display the “Dictionary” panel during your course to look up unfamiliar 
words or terminology.  This dictionary will open another pop-up window 
linking you directly to the Merriam-Webster Dictionary site. This 
dictionary also has a Spanish/English interactive tab. 
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My Training & Development Page Icons 

This screen shot shows information you will see on your homepage. 
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My Training & Development Page Icons 

This table explains the corresponding icons and links you will see on your homepage. 
 

Icon/Button What it does 
Development Plan Name Lists the name of the development plans.  Development plans are groups 

of courses assigned to you.  

 Click the plus button to expand the section.  This will display all of the 
courses which appear below the course groupings, also known as 
“Development Plans.”  You will probably be assigned to more than one 
Development Plan.  

 Click the minus sign to collapse the section.  This will hide the list of 
courses appearing below the course groupings, also known as 
“Development Plans.” 

Development Plan – 
Date Completed 

Shows the overall completed date of the courses contained within the 
Development Plan.  

• Date:  Displays the last date that all of the courses in the 
Development Plan were completed.  

• NA: Displays when there are still incomplete courses remaining 
in the Development Plan.  

Status Shows the overall status of the courses contained within the 
Development Plan. You can also click the column name to sort it. 

• Complete: Displays when all of the courses contained within the 
Development Plan are completed. 

• Incomplete: Displays when some of the courses contained within 
the Development Plan are completed, but others remain 
incomplete.  

Course Name The course name is displayed in this column. 

Course Name – 
Date Completed 

Displays the date the course was successfully completed (usually the 
date the quiz was passed with an 80% or better score.) 

Status Displays whether a course is Complete, Incomplete, Not Attempted. 

Action Displays the actions you can take on a course, such as view/ print a 
certificate, view course properties or view notes. 

Course Properties  Displays the description and duration of the course. 

  View Notes  
Displays notes you have taken about corresponding course. 

Print Certificate  Displays certificate of course completion. 

Show Legend This toggle display link will show the various icons associate with the 
completion status of a course.  Once you click “Show Legend” the toggle 
display link will read “Hide Legend”. Clicking “Hide Legend” will hide the 
display.  
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Course Legend 

Icons have been assigned to courses based on their status.  Most of the courses do not have due dates 
assigned to them unless they are annually required courses. If that is the case, then you will see an icon 
when a course is due soon or past due from the date you originally completed the course.  The icon 
legend/key is listed below.  Most training currently offered in the learning management system (LMS) is 
classified as “Course” or “Web-based training (WBT).” 

 

How do I check my course grade?  

1. Your certificate displays on your homepage or the “My Training History” on the left 
navigational bar. 

2. You will see a list of all the courses you have completed.  Your score and date of completion 
are also visible on this screen.  

3. Your scores and certificate will automatically be saved and stored on the learning system, so 
you can view them at any time. 

My Training History Page Icons 

Icon/Button What it does 

  Certificate Click and view or print your certificate.  Note that the system also keeps 
a permanent record of your training. 

  View Notes 
Opens a new window that shows any notes you have taken regarding 
the corresponding course. 

 Course Properties Opens a new window that shows a description of the course and the 
approximate course duration (in minutes). 

 Displays the date you began the course. 

 Displays the date you completed the course. 

 
Displays the date you last viewed the course. 

 Displays your course score. 

 
Displays a course’s expiration date. If there is no expiration date, the 
column displays NA (not applicable).  If applicable, the date would 
display.  Most courses have no expiration date. 
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How do I and print my Certificate of Completion? 

1. Click the “Home” link or the “My Training” link or the “My Training History” link. 

2. Click on the certificate icon  appearing in the Actions column. 

3. You can print your certificate by clicking on the print icon in the upper left-hand 
corner of your certificate page.  

4. Your course scores and certificates will automatically be saved and stored on the LMS, so 
you can view them at any time. 

 
 

Course “Notes” Display Window 

If you have taken notes using the Notes  function found in the Course Launch Page, you will be able to 
read each courses notes by clicking the icon next to the course name.  
 
This feature might be useful for reminders to yourself regarding safety tips to implement in your job 
area or for questions you might have regarding questions you need to ask your manager or supervisor 
brought about by the training. You can also print your notes by clicking on the printer icon. 
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System Troubleshooting Tips 

 

 Why doesn’t my certificate print properly? 
You will need to change your internet browser settings to print background images. To do this, follow 
the steps below: 
 

1. Open your web browser (in this step example, we are using Internet Explorer) 
2. Click Tools → Internet Options → Advanced 
3. Scroll down to “Printing” options and checkmark “Print background colors and images” 
4. Click “Apply” 
5. Click “OK”  
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How do I remove the printed headers/footers on my certificate? 
To print your certificate without browser headers/footers appearing on the page: 

 
1. Open your certificate in your web browser window 
2. Choose File > Page Setup from the drop-down menu.  You will see a dialog box similar to the 

screen shot below 
3. Set all drop down fields to “Empty” 
4. Print your page 

 
 
 

 TIP: You can also set up your printer options to— 
• Print landscape 
• Print on legal paper 
• Print Background Colors and Images.  

This option must be selected in order to see the entire certificate 
image. 

• Shrink the image to fit your page margins 
• Set your page print margins 
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Why won’t my training course start? 
Having problems getting a course to start?  It may be your web browser pop-up blocker. To turn off the 
pop-up blocker: 
 

o Click on “Tools” from the dropdown menu in your Internet browser 
o Choose “Internet Options” 
o Click the “Privacy” tab 
o Uncheck the box “Turn on pop-up blocker” 
o Click  “Apply” and then click “OK” 

 

Why won’t my course register as completed – even after I passed? 
Certain courses in the Technology Basics and the Manager Human Resources Specialty Pack require that 
you set up a trusted site to show completions.  Follow the steps below to add the trusted sites:  
 

1. Click on “Tools” from the dropdown menu in your Internet browser  
2. Choose “Internet Options” 
3. Click the “Security” tab 
4. Click the “Trusted sites” icon 
5. Click the “Sites” button 
6. Click on the “Settings” button 
7. Paste the following web addresses into “Add this website to the zone:” 

a. http://verticlimb.learn.com and click “Add” 
b. http://central.mindleaders.com and click “Add” 
c. http://learninguniversity.com and click “Add” 

8. Uncheck the box “Require server verification (https) for all sites in this zone” 
9. Click “Close” 
10. Click “Apply” and “OK” 
11. Close your web browser window and then re-launch a new session. 
12. Return to your LMS web address and login. 

 
You are now ready to begin your course.  
 
 
Some important information about these courses: 
• You must watch the entire course and answer the pop-up questions that appear at different 

points throughout the course.  

• Take the scored quiz after the video is over.  

• Exit the course by clicking the "exit" button at the bottom.  

• The course will not complete if the screen is exited by clicking the "X" at the top-right corner.  

  

http://verticlimb.learn.com/�
http://central.mindleaders.com/�
http://learninguniversity.com/�
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I forgot my password – I know my Username 
If you forget your password, there is an automatic recovery built in so you can change your password to 
a new one through the system screen.

 
 

1. Click the “Forgot Password” link on the login page.    
2. You will be taken to the password recovery page. 
3. Enter your Username 
4. Click “Continue” 
 

 
 

5. Enter the answers to your three password recovery questions. 
6. Click “Verify” 
7. You will be asked to change your password.  Type in your new password. 
8. Click the “Return to Login” link. 
9. Login to the system as usual. 

 
 

I forgot my password – I do not know my Username 
To use the auto-recovery system for a password, you must know your username.  Your username is 
normally structured as the first two letters of your first name, your middle initial, if you gave one, and 
your full last name.  If your last name is hyphenated, use the name to the right of the hyphen only.  If 
you have multiple last names, use the last ordered name as your last name. 
 

 
 

• If you do not know your username, click the “Contact Us” button in the upper right-hand 
corner of your computer screen.  See Help – Contact Support. 

• Someone will reset your password. You must have an email account to send and receive the 
password reset email. Otherwise, you will need to phone us.  
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How do I change my password? 
To change your system password: 

1. Click on the “My Profile” link in the navigation panel 
2. Scroll to the bottom of the page until you see “Change your password and recovery questions” 
3. Change your password 
4. Click “Submit” 

 

 
 

 

I cannot get into the site – I am using the correct Username and password 
The message pictured here usually occurs when the LMS website link is typed incorrectly.  
 

 
 
Please verify that you have the correct LMS website link and that you typed it into the web browser 
address bar correctly.   
 
The LMS link structure is set up like this:  http://verticlimb.learn.com/cli/yourclubnamehere. 
 

• If you have correctly typed the link and know your username and password but are still getting 
this error message please contact the Club Learning Institute. 

 
  

http://verticlimb.learn.com/cli/yourclubnamehere�
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Error: The LearnCenter you have requested is not available  
This error occurs when the LMS website link has been typed incorrectly.  Please check the website link 
information provided to you.   

 
 

 
If you are still having problems, contact the CLI support team and we will email you the correct link.   
 
 
 
 

Help – Contact Support 
Our normal hours of operation are Monday – Friday 8:30am to 5:00pm CST.  
 
We are closed on all major holidays.   Please feel free to email us with a support question as we may be 
able to assist you during these off hours.  We make every attempt to check support email on weekends.   

 
Email:  support@clublearninginstitute.org 
Toll free:  1-877-814-4254 (1-877-814-4CLI) 
 

 

mailto:support@clublearninginstitute.org�
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